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Introduction to ProMotion®

Thank you for choosing ProMotion, the first choice in hardware graphics and motion video acceleration.
ProMotion offers superfast Windows performance, a wide variety of software drivers, and 100%
compatibility combined with state-of-the-art hardware motion video acceleration. With today's Multi
Media User interfaces (MMUI) making new demands on personal computer hardware, you need
acceleration for graphics as well as full-motion video. ProMotion MMUI accelerators are the first choice
for today and tomorrow.

ProMotion meets the needs of serious users:

• accelerated, scaleable full-motion video.

• Truecolor photo-realistic display of up to 16.7 million colors.

• Memory configurations of 1 MB and 2 MB.

• Graphics resolutions from 640×480 to 1600×1200.

• Compatibility with VGA and industry standards.

The Alliance Logo, and ProMotion® are registered trademarks of Alliance Semiconductor. All other
trademarks are the property of their respective holders.
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Check the disk(s) included with your ProMotion card for README files before installing any
drivers. README files contain material released since this manual was published.

Technical Support

Contact the manufacturer of your accelerator card for customer support or the latest software drivers.

Please write down the make and model of your computer, what kind of BIOS and motherboard you use,
what is your operating system version, and printout your AUTOEXEC.BAT and CONFIG.SYS files
before you contact technical support. Describe clearly to the support personnel what actually happened as
well as what was supposed to happen when the problem occurred.

FCC Information

This device has been tested and found to comply with the limits for a Class B digital device pursuant to
part 15 of the FCC rules. These limits are designed to provide reasonable protection against harmful
interference in a residential installation. This equipment generates, uses, and can radiate radio frequency
energy. If not installed and used in accordance with the instructions this device may cause harmful
interference to radio communications. However, there is no guarantee that interference will not occur in
any particular installation. If this equipment does cause harmful interference to radio or television
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reception, which can be determined by turning this equipment on and off, the user is encouraged to try to
correct the interference by one or more of the following:

• Reorient or relocate the receiving antenna.

• Increase the separation between the equipment and the receiver.

• Connect the equipment into an outlet on a circuit different than that to which the receiver is
connected.

• Consult the dealer or an experienced radio/TV technician for help.

Any changes or modifications not expressly approved by Alliance could void the user’s authority to
operate this equipment.
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1. ProMotion Hardware

1.1. Installing a PCI Bus ProMotion Card
1) Turn off the power to your computer and remove the cover. Locate an empty PCI slot and remove

the screw which secures the plate over the slot's slot-cover.

2) Insert the ProMotion card into one of the empty PCI slots of your computer. Press firmly as you
insert the card, making certain the edge connector is seated properly in the slot.  Replace the screw
removed in step one to secure the ProMotion card in place.

3) Plug a VGA cable from your monitor into the connector on the card.

4) Replace the computer's cover, and turn the power on.

Adding graphics cards to some PCI systems with sound cards may cause IRQ conflicts. If you
find your sound card does not initialize or play properly after adding a PCI card, try changing IRQ
settings for your sound card or try moving the new PCI card to another PCI slot.

Install appropriate software drivers as directed in the next part of the manual to fully enjoy your
accelerated PCI ProMotion graphics and video card!
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1.2. Installing a VESA™ VL-Bus ProMotion Card
1) Turn off the power to your computer and remove the cover. Locate an empty VL-Bus slot and

remove the screw which secures the plate over the slot's slot-cover.

2) Insert the ProMotion card into one of the empty VL-Bus slots of your computer. Press firmly as you
insert the card, making certain the edge connector is seated properly in the slots. Replace the screw
removed in step one to secure the ProMotion card in place.

3) Plug a VGA cable from your monitor into the connector on the card.

4) Replace the computer's cover, and turn the power on.

Install appropriate software drivers as directed in the next part of the manual to fully enjoy your
accelerated VL-Bus ProMotion graphics and video card!
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1.3. ProMotion Graphics Modes

The following table displays the modes supported by ProMotion with different memory configurations.

256 Colors 32K/64K colors 16M colors

1600 × 1200 2MB - -

1280 × 1024 2MB 4MB -

1152 × 864 1MB 2MB -

1024 × 768 1MB 2MB 4MB

800 × 600 1MB 1MB 2MB

640 × 480 1MB 1MB 2MB
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2. ProMotion Software

This chapter is divided into sections according to the software drivers available. You do not have to read
all the sections, but rather only the installation notes for the software you plan to use with the ProMotion
card.

Before starting, it is a good idea to make a backup copy of your installation diskette(s). Use this copy for
installations and place the original in a safe place.

These installation notes assume you have a hard disk C: and you are installing from floppy drive
A:. If your setup is different, you must substitute drive letter(s) as appropriate.
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2.1. Installing MS-DOS drivers

This section includes instructions for installing the ProMotion MS-DOS display driver files. The
ProMotion DOS refresh rate utilities include the following items: REF_UTIL.EXE, CALCREF.EXE, and
SETCRTC.COM.

Installation and the setup utility must be launched from the DOS prompt. You may modify any choice
after installation using the program REF_UTIL.EXE.

The installation modifies your AUTOEXEC.BAT file with a call to SETCRTC.COM, and for some
machines there is an additional call to 6422CNFG.EXE.

1) Insert the driver disk containing the DOS refresh rate utilities and enter the following command from
the DOS command line, as appropriate for your floppy drive:

a:\dos6422\install

Use an appropriate letter for the drive containing the drivers disk.

2) The installer creates a directory for the ProMotion drivers, with C:\DOS6422 as the default. You may
change this directory at the time of installation.  It will take a few moments to copy the files to your
hard disk. The DOS driver files are installed regardless of whether you have a ProMotion card
installed in your system.



6

3) The ProMotion DOS Utilities installer determines whether you have a ProMotion card in your system
before attempting to configure the hardware. If a ProMotion card is found, the installation
automatically scans and configures refresh rates for your system.

4) ProMotion DOS display drivers are now installed on your computer. You may modify any choice
after installation using the program REF_UTIL.EXE.

2.1.1. REFUTIL.EXE

REF_UTIL.EXE is a DOS program. Run this program from the DOS command line to set the refresh
rates stored in MONITORS.DAT.

1) Enter REF_UTIL from the DOS command line.

2) Use either a keyboard combination <ALT> + <highlighted key> or a mouse to make selections from
the menus at the top of the screen: File; Monitor; Refresh; Help.

Use the File menu to save your configuration or to exit the program. If you save changes. REF_UTIL
saves the old AUTOEXEC.BAT and CONFIG.SYS as AUTOEXEC.ASC or CONFIG.ASC.

Use the Monitors menu to show the current monitor setting or to select your specific monitor type; select
General or Unlisted monitor if your particular monitor is not on the list.

Use the Refresh menu to show or to change the refresh rate for a given display resolution. Each refresh
rate may be altered individually from the Refresh menu. The following is an example of the
configuration window shown using the Refresh menu.
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Sample Configuration:

640×480 60 Hz

800×600 72 Hz

1024×768 60 Hz

1152×864 60 Hz

1280×1024 66 Hz

1600×1280 60 Hz

Use the Help menu to get on-line help for REF_UTIL.EXE, or to determine the program version number.

2.1.2. CALCREF.EXE

CALCREF.EXE is a DOS program used to automatically calculate actual refresh rates used by the
hardware. Run this program from the DOS command line. Follow the on screen directions to select each
resolution and color depth.

1) Enter CALCREF from the DOS command line
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2) If you wish to calculate refresh rate, select a resolution by pressing its number (1-6). .

3) Select the color depth for that resolution by pressing its number (1-4). A message appears warning
you that the screen will be blanked for 10–12 seconds while CALCREF determines the proper
refresh rate.

4) Press E to exit CALCREF.EXE, or any other key to start over at step 1. Changes are automatically
saved.

2.1.3. SETCRTC.COM

SETCRTC.COM is a terminate-and-stay-resident (TSR) program used at bootup to load refresh rate
values stored in MONITORS.DAT. Your AUTOEXEC.BAT should run this TSR at bootup time to
automatically load the refresh rate data. Note that a successful loading of the TSR displays a list of
refresh values during the boot process.
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2.2. Installing Windows 3.x drivers

This setup utility must be launched from within Windows to install ProMotion Windows 3.x display
driver files.

1) Start Windows using its included generic VGA driver (640×480 resolution). Refer to your Windows
documentation if you need assistance. If you have been using a different high-resolution graphics
drivers then you should use Windows Setup to select the 640 × 480 VGA driver before starting
Windows.

2) Once Windows is running, with the ProMotion driver diskette in your floppy drive, select Run from
the File menu of the Program Manger. Enter the following as the command line:

a:setup

Use an appropriate letter for the drive containing the drivers disk. A window appears with three
menus: Display, Desktop, and Card.

3) Choose your monitor type from the ProMotion Display menu. If your exact model of monitor is not
shown, choose the "generic display" or enter custom refresh rates for the "unlisted display" (refer to
your monitor's documentation for the frequencies it supports). Click the OK button to proceed.

4) Select the color depth, resolution, and font size from the ProMotion desktop menu. Click the OK
button to proceed. It will take a few moments to copy the files to your hard disk.

5) ProMotion Windows display drivers are now installed on your computer. Click the button for
"Restart Windows" in order to use the new drivers.
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You may modify any choice after installation from the ProMotion control panel. Double click the Control
Panels icon, usually found in the Main program group. Double click the ProMotion icon to change
ProMotion settings. The three categories are Desktop, Display, and Card.

2.2.1. Desktop

The Desktop window allows you to change settings for colors (256, 32,768, 65,536, and 16.7 million),
font size (small and large), and resolution (640×480, 800×600, 1024×768, 1152×864, 1280×1024, and
1600×1280).  Because colors and resolutions are dependent on memory and display type, higher color
depths are not available at higher resolutions (refer to section 1.3 for a chart).

2.2.2. Display

The Display window allows you to change settings for display type and vertical refresh rates. If your
exact display is not listed in the display type then select the option for "Generic" or select "Unlisted
Display" and modify values for any refresh rate. A higher value refresh rate tends to flicker less when
your eyes are tired, but not all monitors are capable of higher refresh rates.

2.2.3. Card

The Card window allows you to change the setting for Memory Address, and display the version
numbers of your ROM and ProMotion Windows drivers. The typical user doesn't need to change the
default setting for memory address.
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2.3. Installing Windows 95 drivers
1) Open Display, found in the Control Panels folder of My Computer. A window appears named

Display Properties.

2) Click on the Settings tab at the top right of this window. Click on the button for Change Display
Type found in the lower right. A window appears named Change Display Type.

3) Click on the Change button to the right of Adapter Type, found at the top of the window. A window
appears named Select Device.

4) Click on the button for Have Disk, found on the right side. A window appears named Install From
Disk.

5) In the space under Copy Manufacturer’s Files From, type the path to the location of the ProMotion
driver files, or click on Browse to search for the proper directory. Select the file PROMOTN.INF.
For example, if you’re installing from a floppy disk, use the path name:

A:\PROMOTN.INF

With PROMTN.INF selected, click OK three times to close the front three windows, leaving the
window for Change Display Type in front.

6) Click on the button for Close. When the Settings window is in front, click on the button for Apply.
Windows 95 now restarts with your ProMotion driver active.
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2.4. Installing Windows NT drivers
1) Login Windows NT using its included generic VGA driver (640×480 resolution). Refer to your

Windows NT documentation if you need assistance. This is most important if you have installed
other high-resolution drivers previous to installing your ProMotion card.

2) Open the Display control panel. Click the button for "Change Display Type."

3) In the new window, under Adapter Type, click the button for "Change."

4) In the new window, under Select Device, click the button for "Other."  A window appears asking for
the path to the ProMotion installer. Enter an appropriate path and click the button for "OK."

Versions of NT prior to 1.0.2 install drivers only from the root directory of a floppy (such as A:\ or
B:\ ).  You may need to copy the drivers to the root directory of a blank diskette if your
distribution disk has ProMotion NT drivers in a subdirectory.

5) Select one of the ProMotion options. Click the button for "Install." If Windows NT asks you to
disable the currently installed driver, click the button for "Yes." A new window appears asking for
the path to the ProMotion drivers. Click the button for "Continue." It will take a few moments to
copy the files to your hard disk.

6) ProMotion Windows NT display drivers are now installed on your computer.

Use the Display control panel to change and test ProMotion settings at a later time.
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2.5. Installing OS/2 drivers

These instructions assume you have installed OS/2 in directory c:\os2 and you are installing from floppy
drive a.

1) Reset your display adapter support to VGA. Refer to your OS/2 documentation Installation Manual
for assistance. This is most important if you have installed other high-resolution drivers previous to
installing your ProMotion card.

2) From the OS/2 desktop open the OS/2 System icon.

3) Open the Command Prompts icon in the OS/2 System window.

4) Open the OS/2 Full Screen icon.

5) With the OS/2 drivers diskette in drive A, enter the following command:

copy a:\*.dsc c:\os2\install

Use an appropriate letter for the drive containing the drivers disk. Copying this allows the Alliance
drivers to appear to the installation program.

6) Run DSPINSTL.EXE from the directory c:\os2\install.

7) Select Primary Display and click the button for "OK."

8) Select Alliance Display Drivers and click the button for "OK." At this point some versions of OS/2
display a warning about support for display adapters. Click on the button for "OK."
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9) A window appears asking for the path to the ProMotion installer, such as A:\PRO-OS2\SETUP. Enter
an appropriate path and click the button for "OK."

10) ProMotion OS/2 display drivers are now installed on your computer. You will be asked to restart
OS/2.  Click the button for "OK."

11) Exit the command interpreter with the EXIT command.

12) Shut down OS/2 and reboot the computer. If the message asking you to PLEASE WAIT remains for
more than a minute, you likely need to reset the computer manually.
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2.5. Installing WordPerfect 6.0 DOS drivers

If you have installed other high-resolution video drivers previously, you should remove old drivers from
the WordPerfect directory. Be certain to copy any files you may need later before you delete them. Do
not remove WordPerfect's IBM.VRS.

1) Copy the file PROMTN.VRS from the floppy disk to your WordPerfect directory.

xcopy a:\wpdriver\promtn.vrs c:\wp60

Use an appropriate letter for the drive containing the drivers disk. Refer to your MS-DOS
documentation if you need assistance.

2) ProMotion WordPerfect for DOS display drivers are now installed on your computer. You now must
configure the drivers from within WordPerfect. Launch WordPerfect.

3) From the File menu select Setup.

4) Select Display.

5) Select Graphics Mode.

6) Select Screen.

7) Select ProMotion SVGA driver. If there is no ProMotion choice here, verify that you copied the
PROMTN.VRS driver file to the proper directory in step 1).

8) Select the resolution you wish to use, and exit. This ends the configuration process.
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2.6. Installing Video for Windows v1.1D
This section includes instructions for installing Video for Windows driver files.

1) Start MS Windows. With the Video for Windows diskette in your floppy drive, select Run from the
File menu of the Program Manger. Enter the following as the command line:

a:setup

Use an appropriate letter for the drive containing the drivers disk.

2) In the new window, click the button for "Continue." It will take a few moments to copy the files to
your hard disk.

3) Video for Windows is now installed on your computer. In the new window click the button to restart
Windows.
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2.7. Installing Xing MPEG Player

Your ProMotion card may be bundled with MPEG playback software from XING Technology. This
software requires a CD ROM drive and a Pentium-class processor for high frame rate. The Xing software
permits MPEG video playback without a dedicated MPEG card.

You must first install Video for Windows or another DCI-compliant driver in order to use the Xing
MPEG player.

If your installation disk includes the file XPLAY_09.EXE in the root directory then start with Step 1.
XPLAY_09.EXE is a compressed archive which must be decompressed before the installation can occur.
If SETUP.EXE appears in the root directory without XPLAY_09.EXE, then the installation files are fully
decompressed, so start with Step 4. If both files XPLAY_09.EXE and SETUP.EXE are in the root
directory then start with Step 1 to guarantee proper installation

1) From the DOS command line or a MS-DOS box within MS Windows create a temporary directory.

mkdir c:\xtemp

2) Copy the compressed file XPLAY_09.EXE to this temporary directory, make the directory current,
and decompress the self extracting archive by entering the following commands.

cd \xtemp

xcopy a:\xplay_09.exe
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xplay_09 -d

It is important to enter the -d option in order to create the proper subdirectories. It will take a few
moments for the files to be extracted from the archive to this temporary directory.

3) Make an installation floppy disk for future use. Put a blank floppy disk into your drive and enter the
following command.

xcopy c:\xtemp *.* a:\ /s

It is important to enter the /s option switch in order to create the proper subdirectories.

4) The following steps must be done from within MS Window; start MS Windows if it is not running.
With the Xing MPEG driver disk in your CD or floppy drive, select Run from the File menu of the
Program Manger. Enter the following as the command line:

a:\setup

Use an appropriate letter for the drive containing the drivers disk.

5) A window appears asking if you agree to the software license terms. Click YES with your mouse to
proceed with the installation.

6) A window appears asking for the destination installation directory. The default directory is C:\XING.
Make changes if required and click OK to continue. It will take a few moments to copy the files to
your hard disk.

7) A window appears with options for the Xing MPEG Screen Saver. The defaults install the Xing
software as your current screen saver and copy the sample movie(s) to your hard disk. Click the
button for INSTALL or SKIP, as appropriate.  It will take a while to copy movie(s) to your hard disk.
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Due to file size constraints, floppy installation disks do not include any MPEG sample files. No
movies are installed from floppy disk regardless of your selections.

8) Restart Windows to use your new Xing MPEG Player software.
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2.8. Installing panaStation v1.x drivers

This section includes instructions for  installing the ProMotion panaStation driver files.

1) Insert the panaStation disk into your floppy disk drive. Enter the following command.

a:\panastat\install

Use an appropriate letter for the drive containing the drivers disk.

2) After completing the registration information, panaStation will prompt you for information about
your MicroStation installation. Verify that the given information is correct and then press ENTER. It
will take a few moments to copy the files to your hard disk. For TIGA installations only, you must
copy the file DLDEXT.RLM from your panaStation sub-directory to your TIGA software sub-
directory.

3) From your \USTATION sub-directory type the following.

usconfig

4) Use your arrow keys to highlight the DISPLAY ADAPTERS option. Press the ENTER key to display
the Right Screen Graphics Adapter menu. From the list of available display drivers, highlight Vendor
Supplied Driver and press ENTER. Next highlight panaStation from the list of vendor supplied
drivers. Press ENTER to continue to the Left Screen Graphics.

5) If you are configuring a single monitor system, highlight No Second Adapter and press ENTER to
display the Virtual Swap Screen dialog box. When using panaStation, MicroStation's Virtual Swap
Screen feature is available to all graphics boards. On graphics boards using dual page memory
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switching, the page swap is done using the graphics board hardware. On all other graphics boards,
the page swap is simulated by panaStation.

6) To use virtual page swapping, answer "N" to the "Do you want to disable the virtual graphics page?"
question. To disable virtual page swapping answer "Y". Once the Swap Screen question has been
answered you will return to the Main Configuration menu.

7) If you are configuring a dual monitor system, highlight Vendor Supplied Driver from the list of
available display drivers. As with the Right Screen Graphics Adapter, highlight panaStation, by
Panacea, Inc. from the list of vendor supplied drivers. Press ENTER to return to the main
configuration menu.

8) At the main menu, highlight Exit and Save to exit the USCONFIG program and return to the DOS
prompt. The panaStation drivers are now installed on your computer.

9) In order for the new panaStation driver to take effect it is necessary to re-boot your computer. Turn
off the power to your system or press the RESET button if you have one. After re-booting change to
your \USTATION directory and type:

ustation

to start MicroStation. Upon startup of MicroStation you will be greeted with the panaStation
welcome screen. If you do not see the welcome screen, be sure you have properly selected
panaStation from the list of vendor supplied drivers and that you have re-booted your computer.

10) Once you have read through the panaStation welcome message, press any key to continue to the Left
Screen Main Configuration menu. You will need to configure panaStation for use with your graphics
board type and the resolution under which you wish to run MicroStation. Use your arrow keys to
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highlight Select Graphics Board/Resolution and then press ENTER to display the Select Graphics
Board/Resolution menu.

11) The Select Graphics Board/Resolution menu configures panaStation settings for graphics board/type
and display and rendering resolutions. Choose Select Graphics Board to manually select the
ProMotion graphics board. A list of options is given, based on the findings of panaStation's built-in
graphics platform detection utility. Use the Up and Down arrow keys, and the Pg Up and Pg Dn keys
to scroll through the list and highlight ProMotion.

12) panaStation includes a graphics platform detection utility that queries the graphics card for type, Hi-
Color support and installed memory. Based on the graphics platform detector's information,
panaStation will list a set of Display/Rendering resolutions. Due to the variety of graphics boards and
their specific implementations of platform chip sets, the detector is not always accurate. Therefore,
when selecting a Display or Rendering resolution, be sure to use only resolutions that your
ProMotion memory configuration supports, as detailed in Section 1.3. Press ENTER to accept your
choice and return to the Select Graphics Board/Resolution menu.

13) Choose Select Display Resolution to configure the display/rendering resolution of your MicroStation
screen. Display/rendering options are also based on the findings of panaStation's graphics platform
detection utility. Use the Up and Down arrow keys, and the Pg Up and Pg Dn keys to scroll through
and highlight the resolution and color option you wish to use. Press the ENTER key to accept your
resolution choice and return to the Select Graphics Board/Resolution menu.

13 panaStation provides you the option of adjusting the aspect ratio of your MicroStation screen. To
change the default aspect ratio, select the Adjust Aspect Ratio menu and measure, in millimeters, the
height and width of the Aspect Ratio dialog box. Enter the measured values in the corresponding
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height and width data boxes. Highlight Return to Previous Menu and press the ENTER key to return
to the Main Configuration menu.

14) When configuring a dual screen MicroStation configuration, panaStation allows you to select which
monitor will display text and which will display graphics. To designate a monitor for text, select the
Dual Screen Configuration menu and simply choose Left if you wish to have the text appear on the
monitor configured as MicroStation's Left screen. Or, choose Right if you would like text to appear
on the monitor configured as the Right screen. Highlight Return to Previous Menu and press the
ENTER key to return to the Main Configuration menu.

15) When configuring a dual monitor system a Right Screen Main Configuration menu will be displayed.
Configure for the second screen as you did for the Left Screen above.

16) Once all of the panaStation parameters have been configured, select SAVE, EXIT to save the
configuration information and create PANACFG1.DAT and, for dual screen configurations,
PANACFG2.DAT in the \USTATION sub-directory. After the PANACFG files have been created,
MicroStation will start up with the newly selected panaStation resolution.

If panaStation has already been configured, upon starting MicroStation you will be asked whether you
would like to re-configure. Type Y to go to the panaStation Main Configuration Menu or N to start
MicroStation.

If you start MicroStation from a sub-directory other than the \USTATION sub-directory you gave
during installation, PANACFG files will be created in that directory.
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2.9. Installing AutoCAD TurboDLD Lite drivers

This installation assumes your AutoCAD files are in the directory C:\ACAD and the floppy drive you're
installing from is drive A:, and that you wish to install the new drivers to C:\ACAD\DRV. If your system
is different, then make appropriate changes.

1) Run the TurboDLD Lite installation program by typing:

a:\turbodld\install

Use an appropriate letter for the drive containing the drivers disk. TurboDLD Lite's install program
asks for registration information and then prompt for AutoCAD information. The remaining prompts
ask for sub-directory information. After all information has been provided,  TurboDLD Lite files are
now copied from the distribution floppy to the hard drive.

2) Begin AutoCAD with the re-configure switch by typing

acadr12 -r

Choose option 3, Configure Video Display from the AutoCAD configuration menu. Type Y at the
"Do you want to select..." message to display the available video options for AutoCAD. Select
"TurboDLD Lite by Panacea Inc." from the list of display options. Continue installation at step 3
below.
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AutoCAD
Release
10/386 or
11

To Configure AutoCAD Release 10/386 or 11, Run the FASTACAD batch file created in your
TurboDLD Lite sub-directory and then start AutoCAD. Re-configure AutoCAD to use TurboDLD
Lite by selecting option 5, Configure AutoCAD from the AutoCAD main menu. From the next
menu, select option 3, Configure Video Display.  Choose Item 1, P386 ADI 4.0/4.1 (R11) or ADI
P386 (R10), as your display device. (For more information, see your AutoCAD "Installation and
Performance Guide.") After selecting the proper display device, the TurboDLD Driver Configuration
menu will appear.

3) The first menu, Select Graphics Board/Resolution, configures TurboDLD Lite for the graphics board,
and display and rendering resolutions to be used. Note that Rendering menu options only appear
when configuring the rendering screens of AVE Render, 3D Studio and AutoShade2 with
RenderMan.  You will not see both menu options at the same time.

4a) Basic Configuration options set AutoCAD screen characteristics, number of text lines in the
command-line area, font size and screen configuration mode.

4b) Expert Configuration options set the function of TurboDLD itself. This menu allows for
customization of the driver for speed or to adjust for memory constraints.

5) Once all options have been set, scroll down to the Save and Exit option and then press the ENTER
key to continue.

6) Next, configure the AutoCAD screen display characteristics and then type Y to accept the changes.
Exit to the AutoCAD drawing editor to begin using TurboDLD Lite.
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7) From the AutoCAD Command Line, type DLDCOLOR, to start CustomColors, TurboDLD's color
configuration utility. Make any desired color changes and then Save the new color palette and then
Exit to return to the drawing editor.
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3. Troubleshooting

Problem Solution

After DOS driver installation,
refresh rates under DOS are
not the values set.

For the refresh values to take affect, the SETCRTC.COM TSR
must be loaded.  Make sure it is actually being executed from
your AUTOEXEC.BAT.

Make sure a ProMotion-based card is in your machine.

Not enough memory to run
REF_UTIL.EXE.

Boot up off a floppy and try executing REF_UTIL.EXE or
A:\DOS6422\INSTALL.BAT again.

REF_UTIL.EXE will not run. Make sure a ProMotion-based card is in your machine (vs.
some other card).

Can not set refresh rates in
DOS to user defined values
when running REF_UTIL.EXE.

Select monitor as "Unlisted Display" with REF_UTIL.EXE.

DOS mouse doesn't work. Verify you have loaded a DOS mouse driver such as
MOUSE.COM or MOUSE.SYS.
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Windows 3.x image on the
screen is blurred, torn, or
skewed, or the screen is blank

It is likely you selected a resolution or refresh rate higher than
your monitor can support. To correct an unusable setting for
resolution or refresh rate, you must re-configure the software.

Use Windows Setup from DOS (typically you would use
SETUP.EXE from the C:\WINDOWS directory; refer to your
Windows documentation for help with Windows Setup). Switch
from the current video setting to the generic "ProMotion Card"
setting. This setting restores basic 640×480 VGA and permits
you to start Windows and use the ProMotion control panel to
try another ProMotion resolution.

Windows NT image is blurred,
torn, or skewed, or the screen
is blank

it is likely you selected a resolution or refresh rate higher than
your monitor can support. Start Windows NT using the option
for 'last working video driver.' Refer to your Windows NT
documentation for assistance.

OS/2 image is blurred, torn, or
skewed, or the screen is blank

It is likely you selected a resolution or refresh rate higher than
your monitor can support. You may have to restart OS/2 with
its generic VGA driver in order to try another setting for the
ProMotion card.

OS/2 doesn’t recognize the
installation floppy disk.

Verify the installation disk label is “PROMOTION 1” (without
the quotes). Note the space between the word and numeral.
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WordPerfect image is blurred,
torn, or skewed, or the screen
is blank

It is likely you selected a graphics mode that your monitor
cannot support. You may have to remove the ProMotion driver
from the WordPerfect directory, start WordPerfect using its
generic VGA driver, quit, and restart from step 1.

panaStation error message
using Help.

The PSTATION.HLP file MUST be present in order for help
information to appear. Be sure that the file PSTATION.HLP is
in the MicroStation sub-directory given during installation.


